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Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking between service provider Fibrenoire and Avaya IP Office Release 10.

Fibrenoire SIP Trunk Service (Fibrenoire) provides PSTN access via a SIP trunk between the
enterprise and the Fibrenoire network as an alternative to legacy analog or digital trunks. This
approach generally results in lower cost for the enterprise.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Fibrenoire is a member of the Avaya DevConnect Service Provider program. Information in
these Application Notes has been obtained through DevConnect compliance testing and
additional technical discussions. Testing was conducted via the DevConnect Program at the
Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the procedures for configuring Session Initiation Protocol (SIP)
Trunking between Fibrenoire and Avaya IP Office solution. In the sample configuration, the Avaya
IP Office solution consists Avaya IP Office 500V2 Release 10, Avaya embedded Voicemail, Avaya
IP Office Application Server (with WebRTC and one-X Portal services enabled), Avaya
Communicator for Windows (SIP mode), Avaya Communicator for Web, Avaya H.323, Avaya SIP,
digital and analog endpoints. The enterprise solution connects to the Fibrenoire network.

The Fibrenoire referenced within these Application Notes is designed for business customers. The
service enables local and long distance PSTN calling via standards-based SIP trunks as an alternative
to legacy analog or digital trunks, without the need for additional TDM enterprise gateways and the
associated maintenance costs.

2. General Test Approach and Test Results

The general test approach was to configure a simulated enterprise site using Avaya IP Office
connecting to Fibrenoire.

This configuration (shown in Figure 1) was used to exercise the features and functionality tests
listed in Section 2.1. Note: NAT devices added between Avaya IP Office and the Fibrenoire
network should be transparent to the SIP signaling.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent to
the interoperability of the tested products and their functionalities. DevConnect Compliance Testing
is not intended to substitute full product performance or feature testing performed by DevConnect
members, nor is it to be construed as an endorsement by Avaya of the suitability or completeness of
a DevConnect member’s solution.

2.1. Interoperability Compliance Testing

A simulated enterprise site with Avaya IP Office was connected to Fibrenoire. To verify SIP
trunking interoperability, following features and functionality were exercised during the
interoperability compliance test:

e Incoming PSTN calls to various phone types. Phone types included Avaya H.323, Avaya
SIP, digital, and analog telephones at the enterprise. All inbound PSTN calls were routed to
the enterprise across the SIP trunk from the service provider.

e Outgoing PSTN calls from various phone types. Phone types included Avaya H.323, Avaya
SIP, digital, and analog telephones at the enterprise. All outbound PSTN calls were routed
from the enterprise across the SIP trunk to the service provider.

e Inbound and outbound PSTN calls from/to the Avaya Communicator for Windows (SIP
mode).

e Inbound and outbound PSTN calls from/to the Avaya Communicator for Web with basic
telephony transfer feature.
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e Inbound and outbound long hold time call stability.

e Various call types including: local; long distance; international call; inbound toll-free;
outbound toll-free during the compliance testing.

e SIP transport using UDP as supported.

e Codec G.711MU.

e Caller number/ID presentation.

e Privacy requests (i.e., caller anonymity) and Caller ID restriction for inbound and outbound
calls.

e DTMF transmission using RFC 2833.

e Voicemail navigation for inbound and outbound calls.

e Telephony features such as hold and resume, transfer, and conference.

e Fax T.38 and G.711 pass-through modes.

e Off-net call forwarding.

e Twinning to mobile phones on inbound calls.

Item not supported include the following:
e Qutbound calls to Assisted Operator.
e 411 Local Directory Assistance Call.
e Use of the SIP REFER method for network redirection (transferring calls with the PSTN
back to the PSTN).
e TLS/SRTP.

2.2. Test Results

Interoperability testing of Fibrenoire was completed with successful results for all test cases with the
exception of the limitation described below:

e Blind Call Transfer using Avaya 1140E SIP phone did not complete until transferee
picked up the call - The expected behavior of the SIP phone was that after transferring, the
phone should display “Transfer successful”. In this case, the user pressed “Trnsfr” button,
answered “No” to the question of “Consult with party?”” which implied the blind transfer, the
transferee phone was ringing and the SIP phone should be released and displaying “Transfer
successful”. Instead, the SIP phone was still displaying “Transferring” and did not release
until the transferee phone answered the call. This is very minor known limitation on Avaya
1140E SIP phone. There was no user impact. Transfer was still completed with 2-way audio.

2.3. Support

For technical support on the Avaya products described in these Application Notes visit:
http://support.avaya.com.

For technical support on Fibrenoire SIP Trunking, contact Fibrenoire at
https://www.fibrenoire.ca/en/sip-trunking-provider.
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3. Reference Configuration

Figure 1 below illustrates the test configuration. The test configuration shows an enterprise site
connected to Fibrenoire through the public IP network. For confidentiality and privacy purposes,
actual public IP addresses used in this testing have been masked out and replaced with fictitious IP
addresses throughout the document.

The Avaya components used to create the simulated customer site included:
Avaya IP Office 500 V2

Avaya embedded Voicemail for IP Office

Avaya Application Server (Enabled WebRTC and one-X Portal services)
Avaya 9600 Series IP Deskphones (H.323)

Avaya 11x0 Series IP Deskphones (SIP)

Avaya 1408 Digital phone

Avaya Analog phone

Avaya Communicator for Windows (SIP)

Avaya Communicator for Web.

Located at the enterprise site is an Avaya IP Office 500 V2 with the MOD DGTL STAL16 expansion
module which provides connections for 16 digital stations to the PSTN, and the extension PHONE 8
card which provides connections for 8 analog stations to the PSTN as well as 64-channel VCM
(Voice Compression Module) for supporting VVolP codecs. The voicemail service is embedded on
Avaya IP Office. The LAN2 port of Avaya IP Office is connected to the public IP network.
Endpoints include Avaya 9600 Series IP Telephone (with H.323 firmware), Avaya 1100 Series IP
Telephone (with SIP firmware), Avaya 1408D Digital Telephones, Avaya Analog Telephone, and
Avaya Communicator for Windows.

A separate Windows 10 Enterprise PC runs Avaya IP Office Manager to configure and administer
Avaya IP Office system.

Mobility Twinning is configured for some of the Avaya IP Office users so that calls to these user’s
phones will also ring and can be answered at configured mobile phones.
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Figure 1 - Test Configuration for Avaya IP Office with Fibrenoire SIP Trunk Service

For the purposes of the compliance test, Avaya IP Office users dialed a short code of 9 + N digits to
send digits across the SIP trunk to Fibrenoire. The short code of 9 was stripped off by Avaya IP
Office but the remaining N digits were sent unaltered to Fibrenoire. For calls within the North
American Numbering Plan (NANP), the user would dial 11 (1 + 10) digits. Thus for these NANP
calls, Avaya IP Office would send 11 digits in the Request URI and the To field of an outbound SIP
INVITE message. It was configured to send 10 digits in the From field. For inbound calls, Fibrenoire
sent 10 digits in the Request URI and the To field of inbound SIP INVITE messages.

In an actual customer configuration, the enterprise site may also include additional network
components between the service provider and the Avaya IP Office such as a session border
controller or data firewall. A complete discussion of the configuration of these devices is beyond the
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scope of these Application Notes. However, it should be noted that SIP and RTP traffic between the
service provider and the Avaya IP Office must be allowed to pass through these devices.
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4. Equipment and Software Validated
The following equipment and software/firmware were used for the sample configuration provided:

Avaya Telephony Components

Equipment

Release

Avaya IP Office solution
= Avaya IP Office 500 V2

10.0.0.1.0 build 53
10.0.0.1.0 build 53

= Embedded Voicemail
=  Avaya Web RTC Gateway 10.0.0.1.0 build 3
n Avaya one-X Portal 10.0.0.1.0 build 16
= Avaya IP Office Manager 10.0.0.1.0 build 53
= Avaya IP Office Analogue PHONE 8 10.0.0.1.0 build 53
= Avaya IP Office VCM64/PRID U 10.0.0.1.0 build 53
= Avaya IP Office DIG DCPx16 V2 10.0.0.1.0 build 53
Avaya 1140E IP Deskphone (SIP) 04.04.23
Avaya 9641G IP Deskphone 6.6.3.02_ V474
Avaya 9621G IP Deskphone 6.6.3.02_ V474
Avaya Communicator for Windows (SIP) 2.1.3.237
Avaya Communicator for Web 1.0.16.1718
Avaya 1408D Digital Deskphone R46
Avaya Analog Deskphone N/A
HP Officejet 4500 (fax) N/A
Fibrenoire Components
Equipment Release
Sonus SBC 5110 V04.02
Broadsoft Broadworks 20 SP1

Note: Compliance Testing is applicable when the tested solution is deployed with a standalone IP
Office 500 V2 and also when deployed with IP Office Server Edition in all configurations.
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5. Configure Avaya IP Office Solution

This section describes the Avaya IP Office solution configuration necessary to support connectivity
to the Fibrenoire. It is assumed that the initial installation and provisioning of the Avaya IP Office
500 V2 has been previously completed and therefore is not covered in these Application Notes. For
information on these installation tasks refer to Additional References Section 9.

This section describes the Avaya IP Office configuration to support connectivity to Fibrenoire
system. Avaya IP Office is configured through the Avaya IP Office Manager PC application. From a
PC running the Avaya IP Office Manager application, select Start - Programs - IP Office 2>
Manager to launch the application. Navigate to File > Open Configuration, select the proper
Avaya IP Office system from the pop-up window and click OK button. Log in using appropriate
credentials.

I3
File Edit View Tools Help

2 AEER] v &2

IP Offices

R B0OTP (2)
¢ Operator (3)

R Select IP Office - o X

Name IPAddress  Type  Version Edition
| Release 10.0
[ Poffice 1 10109214 1P500V2 1000.1.0build 53 _IP Office

TCP Discovery Progress

Unit/Broadcast Address

}]0.10.93.‘4 - Refrest e

Figure 2 — Avaya IP Office Selection
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5.1. Licensing

The configuration and features described in these Application Notes require the Avaya IP Office
system to be licensed appropriately. If a desired feature is not enabled or there is insufficient
capacity, contact an authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels license with sufficient capacity, select IPOffice_1 -
License on the Navigation pane and SIP Trunk Channels in the Group pane. Confirm that there is a
valid license with sufficient “Instances” (trunk channels) in the Details pane.

% Avaya IP Office Manager IPOffice_1 [10.0.0.1.0 build 53] [Administrator(Administrator)] = X
File Edit View Tools Help

IPOffice 1~ ~ License

IP Offices | License

R B0OTP @) License Type ~ Status License Remote Server
B or (3)

License Mode License Normal
Licensec d Version 100

PLDSHostID (111317912166

PLDS File Status  Valid

&
H
% Gro
?é‘ o Feat Instances Stat Expiration Dat Source Add.
A Receptionist 4 Valid Never PLDS Nodal
@ A foicemail Pro Ports 152 Valid Never PLDS Nodal Remoue
@ VMPro Recordings Administrators 1 Valid Never PLDS Nodal
il Essential Edition Additional Voice.. 4 Valid Never PLDS Nodal
@ 4 2 Valid Never PLDS Nodal
" 384 Valid Never PLDS Nodal
- 384 Valid Never PLDS Nodal
Ly 384 Valid N PLDS Nodal
w 100 Valid N PLDS Nodal
i 40 Valid Ne: PLDS Nodal
.( VMPro TTS Professional 0 Valid Never PLDS Nodal
= IPSec Tunnelling 1 Valid Never PLDS Nodal
0 Power User 384 Valid N PLDS Nodal
Avaya IP endpoints 384 Valid Never PLDS Nodal
1PS00 Voice Networking Channels 32 Valid Never PLDS Nodal
Valid Never PLDS Nodal

Figure 3 — Avaya IP Office License
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5.2. System Tab

Navigate to System (1) under the IPOffice_1 on the left pane and select the System tab in the
Details pane. The Name field can be used to enter a descriptive name for the system. In the reference
configuration, IPOffice_1 was used as the name in IP Office.

% Avaya IP Office Manager IPOffice_1 [10.0.0.1.0 build 53] [Administrator(Administrator)] — X
File Edit View Tools Help

a@Ealv 228

IPOffice_1 - System ~ IPOffice_1

IP Offices | System = 1POffice_1 il

BOOTP (2) Name
Operator (3 9 POffice 1 = =
lNam 1POffice_1 ” Locale United States (US English) v

LANT LAN2 DNS  Voicemail Telephony Directory Services SystemEvents SMTP SMDR VCM  VolP  VolP Security Contact Center

T1 Line 3) Location <None> -
& ;”"”‘ U’E;‘g;‘” Contact Information
& Exension

§ User(29)

% Group (1)

9% Short Code (59)

@ service (0)

& RAS (1)

@ Incoming Call Route (7)
2 WAN Port (0)

Set contact information to place System under special control

= Directory (0) Device ID |
£ Time Profile (0) ——
@ Firewall Profile (1) TFTP Server IP Address 255 255 255 255
IP Route (2)
E s (czde © HTTP Server IP Address 0.0 .0 .0
: #f::;eg)” Phone File Server Type Memory Card v HTTP Redirection |Off v
&3 User Rights (9) Manager PC IP Address 255 . 255 . 255 . 255
@ Auto Attendant (0)
€ ARS (1) Avaya HTTP Clients Only [m]

i Location (0)

8 Authorization Code (0 Enable Softphone HTTP Provisioning [ Favor RIP Routes, over static routes
Automatic Backup
Time Setting Configuration Source Voicemail Pro/Manager
Time Settings
Time Server Address 0 0 0 0

Time Offset (hh:mm) |00:00

File Writer IP Address 10 10 9% 78

AVPP IP Address 0 0 0 0

Figure 4 - Avaya IP Office System Configuration
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5.3. LAN2 Settings
In the sample configuration, LANZ is used to connect the enterprise network to Fibrenoire network.

To configure the LAN2 settings on the IP Office, complete the following steps. Navigate to
IPOffice_1 - System (1) in the Navigation and Group Panes and then navigate to the LAN2 -
LAN Settings tab in the Details Pane. Set the IP Address field to the IP address assigned to the
Avaya IP Office LAN2 port. Set the IP Mask field to the mask used on the public network. All other
parameters should be set according to customer requirements. Click OK to submit the change.

%" Avaya IP Office Manager IPOffice_1 [10.0.0.1.0 build 53] [Administrator(Administrator)] - I3
File Edit View Tools Help
a@Ealv -2\
IPOffice.1 - System - IPOffice_1 -
IP Offices | System E7 \POffice_1~ e
L goow (2()3] Heme; System LAN1 [LAN2] DNS  Voicemail Telephony Directory Services SystemEvents SMTP SMDR VCM  VolP  VolP Security ContactCenter
¢ Ope = IPOffice_1
1POffi = VolP  Network Topology
1P Address .10 . % . 14
< Control Unit (4) 5
@ Bxtension (28) 1P Mask 255 . 255 . 255 . 1%
?ﬂ g: L(:f‘)) Primary Trans, IP Address 0.0 .0 .0
9% Short Code (59) Firewall Profile <None> v
@ senvice 0)
o RAS (1) RIP Mode None v
@ Incoming Call Route (7)
£ WAN Port (0) [ Enable NAT
‘“ Directo 0 o Number Of DHCP IP Addresses |1
@ Firewall Profile (1) DHCP Mode
IP Route (2
E A“::':t((ide © O Server O Client O Dialln @ Disabled Advanced
. License (31)
¥ Tunnel (0)
§3 User Rights 9)
8 Auto Attendant (0) oK Cancel Help
LARS (1)
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The VoIP tab as shown in the screenshot on the next page was configured with following settings:

Check the H323 Gatekeeper Enable to allow Avaya IP Deskphones/Softphones using the
H.323 protocol to register.

Check the SIP Trunks Enable to enable the configuration of SIP Trunk connecting to
Fibrenoire system.

Check the SIP Registrar Enable to allow Avaya IP Deskphones/Softphones to register using
the SIP protocol.

Input SIP Domain Name as 10.10.98.14.

The Layer 4 Protocol uses UDP with UDP Port as 5060 and TCP with TCP Port as 5060
Verify Keepalives to select Scope as RTP-RTCP with Periodic timeout 60 and select
Initial keepalives as Enabled.

All other parameters should be set according to customer requirements.

Click OK to submit the changes.
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7

IPOffice_1"

[} v
System LAN1 DNS Voicemail Telephony Directory Services System Events SMTP  SMDR VCM  VoIP VolP Security Contact Center
LAN Settings Network Topology
H.323 Gatekeeper Enable
[[] Auto-create Extension Auto-create User [[] H.323 Remote Extension Enable
H.323 Signaling over TLS Disabled v g 1720 z
[41 SIP Trunks Enable
SIP Registrar Enable
[[] Auto-create Extension/User [C] SIP Remote Extension Enable
| SIP Domain Name |10.10.98.14 I |
SIP Registrar FQDN ‘ ‘
upP UDP Port 5060 = t t (5060 =
Layer 4 Protocol TCp TCP Port 3060 < emot ort {3060 %
s TLS Port 5061 = T ¢ [5061 =
Challenge Expiration Time (sec) 10 =
RTP .
Port Number Range
Minimum 46750 = Maximum 50750 =
Port Number Range (NAT)
Minimum 46750 : Maximum 50750 3
[[] Enable RTCP Monitoring on Port 5005
RTCP collector IP address for phones 0 0 0 0
Keepalives
Scope RTP-RTCP ~ | Periodic timeout
Initial keepalives Enabled v
DiffServ Settings
B8 |3 DSCP(Hex) B8 3| Video DSCP (Hex) |FC 3| DSCP Mask (Hex) 88 3| SIGDSCP (Hex)
46 [5| pscp 46 |3 Video DSCP 63 3] DSCPMask 34 5 SIGDSCP
DHCP Settings
B e Cm e i Aniioc Alceok oo F6CARR 17/ -
oK Cancel Help
Figure 6 - Avaya IP Office LAN2 VoIP
HV; Reviewed: Solution & Interoperability Test Lab Application Notes 13 of 38
SPOC 1/12/2017 ©2017 Avaya Inc. All Rights Reserved. FN-IPO10




On the Network Topology tab in the Details Pane, configure the following parameters:

e Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. No firewall or network address translation (NAT) device was used in the
compliance test as shown in Figure 1, so the parameter was set to Open Internet. With this
configuration, STUN Server will not be used

e Set the Binding Refresh Time (sec) to 60. This value is used as one input to determine the
frequency at which Avaya IP Office will send SIP OPTION messages to service provider to
keep the connection alive

e Set Public IP Address to the IP address of the Avaya IP Office LAN2 port

e Set Public Port for UDP as 5060 (For SIP Trunk with Fibrenoire) and set Public Port for
TCP as 5060 (For SIP phones to register)

e All other parameters should be set according to customer requirements

e Click OK to submit the changes.

i

[ Run 5TUN on startup

IPOffice_1" v | <
System  LAN1 DNS Voicemail Telephony Directory Services  System Events SMTP SMDR  VCM  VolP VolP Security Contact Center
LAN Settings  VolP
Metwork Tepology Discovery
STUN Server Address |D.D.D.D STUMN Port 3478
Firewall/MAT Type Open Internet w
Binding Refresh Time (sec) 60
Public IP Address 10 10 se 14 Run STUN Cancel
Public Port
UDP 5060
TCP 5060
TLS 0
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5.4. System Telephony Settings

Navigate to IPOffice_1 - System (1) in the Navigation and Group Panes (not shown) and then
navigate to the Telephony - Telephony tab in the Details Pane. Choose the Companding Law
typical for the enterprise location. For North America, U-Law is used. Uncheck the Inhibit Off-
Switch Forward/Transfer box to allow call forwarding and call transfers to the PSTN via the
service provider across the SIP trunk. Set Hold Timeout (sec) to a valid number . Set Default Name
Priority to Favor Trunk. Defaults were used for all other settings. Click OK to submit the changes.

=Y IPOffice_1* f v

System LAN1 LAN2 DNS Voicemail | Telephony | Directory Services System Events SMTP  SMDR VCM  VoIP VolP Security Contact Center
Telephony| Park & Page Tones & Music Ring Tones SM CallLog TUI

Analogue Extensions Companding Law 2
Switch Line
Default Outside Call Sequence Normal ~
Default Inside Call Sequence Ring Type 1 a5 © U-LawLine
Default Ring Back Sequence Ring Type 2 v
A-la A-Law Line
Restrict Analogue Extension Ringer Voltage E © & o e
Dial Delay Time (sec) 4 = |1 DSSStatus
Dial Delay Count 0 : D Ao
. = Dial By Name
Default No Answer Time (sec) 15 b g
Show Account Code
Hold Timeout (sec) 3600 S M
= [ Inhibit Off-Switch Forward/Transfer
Park Timeout (sec) 300 =
= [] Restrict Network Interconnect
Ring Delay (sec) 5 S

- Include location specific information
Call Priority Promotion Time (sec) |Disabled

Drop External Only Impromptu Conference

Default Currency usb v
O Visually Differentiate External Call
Default Name Priority Favor Trunk s
[J Unsupervised Analog Trunk Disconnect Handling
Media Connection Preservation Enabled v g - <
High Quality Conferencing
Phone Failback Automatic v

Digital/Analogue Auto Create User
Login Code Complexity

e ’ Directory Overrides Barring

nforcement
Minimum length |4 Py [] Advertise Callee State To Internal Callers
Complexity

RTCP Collector Configuration
[C] Send RTCP to an RTCP Collector

Figure 8 - Avaya IP Office Telephony
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5.5. System VoIP Settings

Navigate to IPOffice_1 - System (1) in the Navigation and Group Panes and then navigate to the
VolIP tab in the Details Pane. Leave the RFC2833 Default Payload as default of 101. Select codec
G.711 ULAW 64K which Fibrenoire supports. Click OK to submit the changes.

IP Offices [ System 7 IPOffice_1* v
R (EJOOT:’ (2(]3) Name. System LANT LAN2 DNS  Voicemail Telephony Directory Services SystemEvents SMTP SMDR VCM VolP Security Contact Center
b erator % |POffice_1
e 1 - Ignore DTMF Mismatch For Phones
Allow Direct Media Within NAT Location [
RFC2833 Default Payload 101
Available Codecs Default Codec Selection

Unused

Selected

G.711 ULAW 64K

G.711 ALAW 64K
G.729(a) 8K CS-ACELP
G.723.1 6K3 MP-MLQ

oute (7) K
.729(a) 8K CS-ACELP
6.723.16K3 MP-MLQ

Figure 9 - Avaya IP Office VolP
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5.6. Administer SIP Line

A SIP Line is needed to establish the SIP connection between Avaya IP Office and Fibrenoire
system. The recommended method for configuring a SIP Line is to use the template associated with
these Application Notes. The template is an .xml file that can be used by Avaya IP Office Manager
to create a SIP Line. Follow the steps in Section 5.6.1 to create the SIP Line from the template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:
e |P addresses
SIP Credentials (if applicable)
SIP URI entries
Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary after
the SIP Line is created via the template. The resulting SIP Line data can be verified against the
manual configuration shown in Section 5.6.2.

Also, the following SIP Line settings are not supported on Basic Edition:
SIP Line — Originator number for forwarded and twinning calls
Transport — Second Explicit DNS Server

SIP Credentials — Registration Required

SIP Advanced Engineering.

Alternatively, a SIP Line can be created manually. To do so, right-click Line in the Navigation Pane
and select New = SIP Line. Then, follow the steps outlined in Section 5.6.2. For the compliance
test, SIP Line 17 was used as trunk for both outgoing and incoming calls.
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5.6.1. Create SIP Line from Template

1. Create a new folder in the computer where Avaya IP Office Manager is installed (e.g.,
C:\Fibrenoire\Template). Copy the template file (Fibrenoire_SIP_Trunk.xml) to this folder.
2. Create the SIP Trunk from the template: Right-click on Line in the Navigation Pane, then
navigate to New from Template - Open from file.
![ Avaya |P Office Manager IPOffice_1 [10.0.0.1.0 build 53] [Administrator(Administrator)]
File Edit View Tools Help
2E ‘ 28
IPOffice_1 v Line 1 ¥
IP Offices Line =
g R BOOTP(2) Line Number Line Type Line SubTy | PRI 24 Line Char
% Operator (3) 1 PRI 24 (Universal) PR '
= a‘JP(‘Jﬁ| _J New R hniversal) PRI Line Number
""" T g cu Ctrl+X Card
..... < Cd
..... & Bd=2 Copy Ctrl+C Port
& g: % Paste Ctrl+V Switch Type
7< Delete Ctrl+Del
,,,,, 8% Sh ~ . Send Service M
..... @D se| v Validate
""" o RA Connect To... Ctrl+T Channel Alloca
~~~~~ In .
,,,,, g W‘[ | New from Template | 4 l Open from file| X
""" @ Di Show In Groups Rdd Mot end £
AAAAA £ Tin Information Elg
""" @ Fir Customize Columns... progress Repla(
~~~~~ IP : ;
VVVVV am A Change Universal PRI Card Line Type » Send Redirectin
----- @ License (31)
% Tunnel (0) Test Number
""" &1 User Rights (%) Clock Quality
----- @ Auto Attendant (0)
----- € ARS (1) CRC Checking
----- &3 Location (0)
438 Authorization Code (0) CSU Operation
Figure 10 — Create SIP Line from Template
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3. Select the Template Files (*.xml) and select the copied template from step 1 at IP Office
template directory C:\Fibrenoire\Template\. Click Open button to create a SIP line from

template.
IP Offices Line = PRI 24 (Universal) - Line 1
)S BOOTP (2) Line Number Line Type Line SubTy| PRI 24 Line Channels
“i## Operator (3) 1 PRI 24 (Universal) PRI -
15 IPOffice 1 2 PRI 24 (Universal) PRI Line Number gl kige SubType
% System (1) "w
17 Line 3) X Open X
=» Control Unit (4)
& Extension (28) <« v ’T‘| > ThisPC » Avaya eSOE (C:) > Fibrenoire > Template v O Search Template p
8 User(29)
2% Group (1) Organize v New folder =~ M @
8% Short Code (59) ~ > s
@ Service (0) # Quick access Name Date modified Type Size
ok RAS (1) ’ 1 i 25/20169:50 AM XM e 4K
e Incoming Call Route (7) B This PC |_| Fibrenoire_SIP_Trunk.xml 11/25/20169:59 AM XML Document 4KB
£ WAN Port (0)
= Directory (0) B Desktop
£ Time Profile (0) |Z] Documents
@ Firewall Profile (1)
KA 1P Route (2) ‘ Downloads
#m Account Code (0) D Music
% License (31) 1 D
& Tunnel (0) &= Pictures
§3 UserRights (9) B videos
@ Auto Attendant (0) =
g ARS (1) ‘i Avaya eSOE (C:) Bn
&8 Location (0)
28 Authorization Code (0) & Network
ing Digits
File name: | Fibrenoire_SIP_Trunk.xml v ‘ Template Files (*xml) v

| Open |v| Cancel

Figure 11 — Create SIP Line from IP Office Template Directory
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A pop-up window below will appear stating success (or failure). Then click OK to continue.

Template Provisicning X

0 New SIP Trunk created successfully using selected template,

Figure 12 — Create SIP Line from Template successfully

4. Once the SIP Line is created, verify the configuration of the SIP Line with the configuration
shown in Section 5.6.2.
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5.6.2. Create SIP Line Manually

To create a SIP line, begin by navigating to Line in the left Navigation Pane, then right-click in the
Group Pane and select New > SIP Line (not shown).
On the SIP Line tab in the Details Pane, configure the parameters as shown below:

Select available Line Number, 17 in this case.

Set ITSP Domain Name to Fibrenoire SIP domain name. This field is used to specify the
default host part of the SIP URI in the To and R-URI fields for outgoing calls.

Set Local Domain Name to IP address of Avaya IP Office LAN2 port. This field is used to
specify the default host part of the SIP URI in the From field for outgoing calls.

Note: For the user making the call, the user part of the From SIP URI is determined by the
settings of the SIP URI channel record being used to route the call (see SIP URI - Local
URI). For the destination of the call, the user part of the To and R-URI fields are determined
by dial short codes of the form 9N;/N“@fn-voip.com” where N is the user part of the SIP
URI and “@fn-voip.com” can be used to override the host part of the To and R-URI.
Check the In Service and Check OOS boxes.

Set URI Type to SIP.

For Session Timers, set Refresh Method to Re-invite with Timer (sec) to 1200.

Set Name Priority to Favor Trunk. As described in Section 5.4, the Default Name
Priority parameter may retain the default Favor Trunk setting, or can be configured to
Favor Directory. As shown below, the default Favor Trunk setting was used in the
reference configuration.

For Redirect and Transfer, set Incoming Supervised REFER and Outgoing Supervised
REFER to Never. Note: Fibrenoire did not support SIP Refer during the compliance testing.
Default values may be used for all other parameters.

Click OK to commit then press Ctrl + S to save.

| Line E7 SIP Line - Line 17 of -8 x| v«
R Line Number - Line Type Line SubTy | [SIP Line| Transport SIP URI VolP T3 Fax SIP Credentials SIP Advanced Engineering
|l 1 PRI 24 (Universal) PRI
i ‘:e -2 PRI 24 (Universal) PRI Line Number 17 3‘
F[Line )] ~[7_ SPlinc] TSP Domain Name [fn-voip.com
= Control Unif
& Exension @) Local Domain Name
§ User2o) Session T
2% Group (1) URI Type SIP « | [ Session Timers
S z:r‘:/r\tc:r(};)d 9) Yocition Cloud S Refresh Method Re-invite ¥
o RAS (1) Timer (sec) 1200 =
@ Incoming Call Route (7)
£ WAN Port (0)
Prefix [
National Prefix I ]
International Prefix
Country Code [ Redirect and Transf
Nome Priority ST = ‘ Incomin g Suj Never 5
PV ‘ Outgoing Supervised REFER Never v
" Send 302 Moved Temporarily (=]
% Authorization Code (0) Outgoing Blind REFER =]
Figure 13 — SIP Line Configuration
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On the Transport tab in the Details Pane, configure the parameters as shown below:

e The ITSP Proxy Address was set to the IP address of Fibrenoire Signaling Server:
192.168.104.164. This is the SIP Proxy IP address used for outgoing SIP calls.

¢ Inthe Network Configuration area, UDP was selected as the Layer 4 Protocol and the Send
Port was set to 5060

e The Use Network Topology Info parameter was set to LAN 2. This associates the SIP Line 17
with the parameters in the IPOffice_1 - System (1) > LAN2 - Network Topology tab.
The Listen Port was set to 5060

e The Calls Route via Registrar was unchecked as Fibrenoire did not support the dynamic
Registration on the SIP Trunk

e Other parameters retain default values

e Click OK to commit then press Ctrl + S to save.

2 SIP Line - Line 17* gk~ X[ v|<

SIP Line SIPURI VolP  T38 Fax SIP Credentials SIP Advanced Engineering

ITSP Proxy Address [192.168.104.164 |

Network Configuration
Layer 4 Protocol upp v Send Port 5060 v

Use Network Topology Info | LAN 2 N4

Explicit DNS Server(s) 0 0 0 0 0 0 0 0

Calls Route via Registrar []

Separate Registrar l

Figure 14 — SIP Line Transport Configuration
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The SIP URI entry must be created to match any DID number assigned to an Avaya IP Office user
and Avaya IP Office will route the calls on this SIP line. Select the SIP URI tab; click the Add
button and the New Channel area will appear at the bottom of the pane (not shown). To edit an
existing entry, click an entry in the list at the top, and click Edit... button. In the example screen on
next page, the previously configured entries are edited.

A SIP URI entry was created that matched any DID number assigned to an Avaya IP Office user.
The entry was created with the parameters shown below:

Set Local URI, Contact, Display Name to Use Internal Data. This setting allows calls on
this line whose SIP URI matches the number set in the SIP tab of any User as shown in
Section 5.8.

Set Identity to Auto and Header to P Asserted ID.

For Forwarding And Twinning, set Send Caller ID to Diversion Header.

Note: When using twinning feature, the calling party number displayed on the twinned phone
is controlled by Send Caller 1D parameter .

Set Diversion Header to None.

Set Registration to 0: <None>.

Associate this line with an incoming line group in the Incoming Group field and an
outgoing line group in the Outgoing Group field. This line group number will be used in
defining incoming and outgoing call routes for this line. For the compliance test, a new line
group 17 was defined that only contains this line (line 17).

Set Max Sessions to the number of simultaneous SIP calls that are allowed using this SIP
URI pattern.

Click OK to submit the changes.
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7 SIP Line - Line 17 ok -l X vl<|>

SIP Line Transport [SIP URI|VoIP  T38 Fax SIP Credentials SIP Advanced Engineering

URl  Groups Local URI  Contact Display Name Identity Header Originator Number Send CallerID Diversion Header Credential Max Calls Add...
1 17 17 <Intemal> <Internal> <Internal> Auto PAI Diversion None 0: <Non... 50
Remove

Edit...

Local URI Use Intemal Datal

Cancel

Contact IUse Internal Data VI
Display Name IUse Internal Data vl
Identity
Identity |Auto v | =
Header P Asserted ID s
Forwarding And Twinning
Originator
Number
Send Caller (D) Diversion Header v
Diversion Header |None v
Registration 0: <None> v
Incoming Group 17 v
Outgoing Group 17 v
Max Sessions 50 =

Figure 15 - SIP Line SIP URI Configuration

Another SIP URI entry was created for the inbound toll-free call testing purpose. In this case, the
Auto setting is used in the SIP trunk’s Local URI, Contact and Display Name fields so that SIP
trunk will accept any incoming call. The entry was created with the parameters shown below:
e Associate this line with an incoming line group in the Incoming Group field. This line group
number will be used in defining incoming routes for this line. For the compliance test, a new
line group 17 was defined that only contains this line (line 17).
e Set Max Sessions to the number of simultaneous SIP calls that are allowed using this SIP
URI pattern.
e Leave the parameters at default values.
e Click OK to submit the changes.
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Ei

SIP Line Transport|SIP URI| volP

T38 Fax SIP Credentials SIP Advanced Engineering

URl  Groups Local URI  Contact Display Name Identity Header Originator Number Send CallerID Diversion Header Credential Max Calls Add...
1 17 17  <Internal> <Internal> <Internal> Auto PAI Diversion None 0: <Non... 50
2 Diversion 0: <Non... 50 Remove

| Cancel

Edit URI
Local URI Y]
Contact IAuto v |
Display Name |[Auto V]
Identity
Identity [Auto v]
Header P Asserted ID v

Originator
Number

Send Caller ID

Forwarding And Twinning

I

‘ Diversion Header

X

Diversion Header INone v
Registration ‘0: <None> vl
Incoming Group |17 v ”

Outgoing Group

IMax Sessions

Figure 16 — SIP Line SIP URI Configuration for Inbound Toll-Free
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Select the VoI P tab to set the VVoice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below:

e The Codec Selection can be selected by choosing Custom from the pull-down menu,
allowing an explicit ordered list of codecs to be specified. The G.711 ULAW 64K codec is
selected. Avaya IP Office supports this codec, which is sent to the Fibrenoire, in the Session
Description Protocol (SDP) offer.

e Check the Re-invite Supported box.

e Set Fax Transport Support to T.38 or G.711 from the pull-down menu. Note: Fibrenoire
supports either Fax T.38 or G.711 pass-through mode.

e Set the DTMF Support to RFC2833 from the pull-down menu. This directs Avaya IP
Office to send DTMF tones using RTP events messages as defined in RFC2833.

e Default values may be used for all other parameters.

e Click OK to submit the changes.

g SIP Line - Line 17* gk-E | X|v]|<

SIP Line Transport SIP URI T38 Fax SIP Credentials SIP Advanced Engineering
[ VolP Silence Suppression

[] Local Hold Music

Codec Selection Custom it l Re-invite Supported

UHUSEd—» ,L [[] Codec Lockdown
G.711 ALAW 64K S35 | G.711 ULAW 64K

G.729(a) 8K CS-ACELP [] Allow Direct Media Path
G.723.1 6K3 MP-MLQ

Force direct media with phones

] PRACK/100rel Supported
<<
G.711 Fax ECAN

Fax Transport Support | T38 v

DTMF Support RFC2833 v
Media Security Disabled v
Cancel Help
Figure 17 — SIP Line VolP Configuration
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5.7. Outgoing Call Routing — Short Code
The following section describes the Short Code for outgoing calls to Fibrenoire.

To create a short code, select Short Code in the left Navigation Pane, then right-click in the Group
Pane and select New (not shown). On the Short Code tab in the Details Pane, configure the
parameters for the new short code to be created. The screen below shows the details of the
previously administered “9N;” short code used in the test configuration.

e In the Code field, enter the dial string which will trigger this short code, followed by a semi-
colon. In this case, 9N;, this short code will be invoked when the user dials 9 followed by
any number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to N“@fn-voip.com”. This field is used to construct the Request
URI and To headers in the outgoing SIP INVITE message. The value N represents the
number dialed by the user. The host part following the “@” is the Fibrenoire domain name.

e Setthe Line Group ID to the Outgoing Group 17 defined on the SIP URI tab on the SIP
Line in Section 5.6.2. This short code will use this line group when placing the outbound
call.

e Setthe Locale to United States (US English).

e Default values may be used for all other parameters.

e Click OK to submit the changes.

| Short Code 7 9ON;: Dial* g -8B X|v=|>

Code  Telephone Number ~ i Short Code
12Nz N
oX13NE N Ete 2 ‘

Feature Dial v

9%*16 Telephone Number N"@fn-voip.com" ‘

] Uine Group D o <]
”™g

%10 Locale United States (US English) ¥
X20°NE N Force Account Code O
@ Incoming Call Route (7) 9X21"NE N ”
€9 WAN Port (0) 9%29

© N"@fn-voip.com"

le ( =
® rofile (1) O

orce Authorization Code [

Figure 18 — Short Code 9N
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The feature of incoming calls from mobility extension to idle-appearance FNE (Feature Name
Extension) is hosted by Avaya IP Office. The Short Code FNEOO was configured with following
parameters:

For Code field, enter FNE feature code as FNEQO for dial tone
Set Feature to FNE Service

Set Telephone Number to 00

Set Line Group ID to 0

Set the Locale to United States (US English)

Default values may be used for other parameters

Click OK to submit the changes.

IP Offices | Short Code 2 FNEOO: FNE Service™ =] X v

R BOOTP (2) Code Telephone Number * || Short Code
o XT12NE N
= PXA1INE N Code FNEOO

7 PX1NE N Feature FNE Service

= ™15

& X6 Telephone Number 00

,‘ =17 Y Line Group ID 0

0 e

e :,,li United States (US English)

g PR20°NE N O

g\z;‘;\‘ b ::;'N’ N Force Authorization Code [

m tory (0) BXON; N"@fn-voip.com"

4 -Ix

i o 2l ¥ oK Cancel Help

Figure 19 — Short Code FNE
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5.8. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP Line
defined in Section 5.6. To configure these settings, first select User in the left Navigation Pane, then
select the name of the user to be modified in the center Group Pane. In the example below, the name
of the user is H323-6935. Select the SIP tab in the Details pane.

The values entered for the SIP Name and Contact fields are used as the user part of the SIP URI in
the From header for outgoing SIP trunk calls. They also allow matching of the SIP URI for incoming
calls without having to enter this number as an explicit SIP URI for the SIP line. The example below
shows the settings for user H323-6935. The SIP Name and Contact are set to one of the DID
numbers assigned to the enterprise provided by Fibrenoire. The SIP Display Name (Alias)
parameter can optionally be configured with a descriptive name. If all calls involving this user and a
SIP Line should be considered private, then the Anonymous box may be checked to withhold the
user’s information from the network.

IP Offices | User = H323-6935: 6935~ S X vi<|> @
/“500“’(3) ;‘:"‘E Etenson DND  Short Codes Source Numbers Telephony Forwarding Dialln Voice Recording Button Programming  Menu Programming Mobility Group Membership Announcements Per < | »
6937 693
603 6930 SIP Name 514XXX6935
g:;‘“io ;gi SIP Display Name (Alias) |H323-6935
i L
fmExtn204 204 Contact [s1a006935
& Extn20: 205
%‘:;:igf’ ;gﬁ [ Anonymous
§rBxn208 208
ErFAX-6938 201
£ WAN Port (0) i H323-6935 6935
= Directory (0) §rH323-6036 6936
#mNoUs:
#mRemoteManags
Figure 20 — User Configuration
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One of the H.323 IP Deskphones at the enterprise site uses the Mobile Twinning feature. The
following screen shows the Mobility tab for User H323-6935. The Mobility Features and Mobile
Twinning boxes are checked. The Twinned Mobile Number field is configured with the number to
dial to reach the twinned mobile telephone, in this case 91613XXX5281. Check Mobile Call
Control to allow incoming calls from mobility extension to access FNEOO (defined in Section 5.7).
Other options can be set according to customer requirements.

7 H323-6935: 6935* ek-EI X vi<l> @

DND Short Codes Source Numbers Telephony Forwarding DialIn  Voice Recording Button Programming Menu Programming Group Membership Announcements SIP Per ¢ | *
[J Internal Twinning
<None>
1
Twin Bridge Appearances
Twin Coverage Appearances
Twin Line Appearances
Mobility Features,

Mobile Twinning

Twinned Mobile Number
(including dial access code

5 [s1613x0xx5281 |

Twinning Time Profile <None> ]
Mobile Dial Delay (sec) 2 |
Mobile Answer Guard (sec) 0 =

[ Hunt group calls eligible for mobile twinning
[] Forwarded calls eligible for mobile twinning
[ Twin When Logged Out

one-X Mobile Client

Mobile Call Control

[] Mobile Callback

Figure 21 — Mobility Configuration for User
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5.9. Incoming Call Route

An Incoming Call Route maps an inbound DID number on a specific line to an internal extension.
This procedure should be repeated for each DID number provided by service provider. To create an
incoming call route, select Incoming Call Route in the left Navigation Pane, then right-click in the
center Group Pane and select New (not shown). On the Standard tab of the Details Pane, enter the
parameters as shown below:

e Set the Bearer Capability to Any Voice.

e Setthe Line Group ID to the Incoming Group 17 defined on the SIP URI tab on the SIP

Line in Section 5.6.2.
e Set the Incoming Number to the incoming DID number on which this route should match.
e Default values can be used for all other fields.

IP Offices | Incoming Call Route Z 17 514XXX6935 e -8 X v<

Line Group ID  Incoming Number Destination Voice Recording | Destinations

-] 200 Main

@0 Dialln

1 514XXX6939 VoiceMail Bearer Capability Aoyi¥oice ¥

@17 514XXX6938 FNEOO Line Group ID ;17 V‘

(-2 514XXX6936 6936 H323-6936

1 S14XXX6937 69376937 Incomin g Number [s1400x6935 |

@17 514XXX6935| 6935 H323-6935 (RS g Sub Address ‘ ‘

eﬂ' 514XXX9307 6935 H323-6935
Incoming CLI [ |
Locale United States (US English) )
Priority 1-Low <
Tag | |
Hold Music Source System Source v
Ring Tone Overrid N |

Figure 22 — Incoming Call Route Configuration

On the Destination tab, select the destination extension from the pull-down menu of the Destination
field. In this example, incoming calls to 514XXX6935 on line 17 are routed to Destination H323-
6935 as below screenshot:

IP Offices \ Incoming Call Route 2 17 514XXX6935" ek - % vz
R BOOTP () Line Group ID  Incoming Number Destination Standard  Voice Recording
4 Josmlor ) gg ZDOOHME'" TimeProfile | Destination Fallback Extension
()W 514XKX6939 v:c:Mall > Default Value 6935 H323-6935 % o
@17 514XXX6938 FNEOO
@17 514XXX6936 6936 H323-6936
Q]T’ 514XXX6937 6937 6937
- T 6935 H323-6935
rvice: 17 514XXX9307 6035 H323-6035
ol RAS (1
@ icoming CoRaea]
2 \éﬁ:‘:;ﬂ(é?) |T| Cancel Help
20 Time Profile () =
Figure 23 — Incoming Call Route for Destination H323-6935
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For Feature Name Extension Service testing purpose, the incoming calls to DID number
514XXX6938 were configured to access FNEOQO. The Destination was appropriately defined as

FNEOO as below screenshot:

IP Offices | Incoming Call Route = 17 514XXX6938 &F - Xlvl=l>
R B00TP 2) Line Group ID._ Incoming Number  Destination Standard  Voice Recording [Destinations]
¢ Operator (3) —
gg éo"HME'" TimeProfile | estinstion | Fallback Extension
ialln
Qu 514XXX6939 VoiceMail > __[Defauft e st ~ h
. Sl 514XXX6938 FNEOD
& @ 51006936 6936 H323-6936
£ Use @ 514006937 69376937
2 r @ S14X006935 6935 H323-6935
@ e 514X09307 6935 H323-6935
% [©)]
“

Figure 24 — Incoming Call Route for Destination FNE

For Voice Mail testing purpose, the incoming calls to DID number 514XXX6939 were configured to
access VoiceMail. The Destination was appropriately defined as VoiceMail as below screenshot:

IP Offices [ Incoming Call Route = 17 514XXX6939 S T
R BOOTP () Line Group ID  Incoming Number ~ Destination Standard  Voice Recording
4 Operator (3
- gg ZD‘?"HM"" TimeProfile Destination | Fallback Extension
jalln
7 519006939 VoiceMail > [DetaukVeluc 4 i
@17 514XXX6938 FNEOO
eﬂ' 514XXX6936 6936 H323-6936
@W 514XXX6937 6937 6937
eW 514XXX6935 6935 H323-6935
17 5140X0307 6935 H323-6935

S file (0)
@ Firewall Profile (1)

Figure 25 — Incoming Call Route for Destination Voice Mail

For Inbound Toll-Free testing purpose, the incoming calls to toll-free number 18449073427,
Fibrenoire was configured to forward the call via the SIP trunk to Avaya with the Request-Line URI
as 514XXX9307. This number was configured on IP Office to route to Destination H323-6935 as

below screenshot:

IP Offices | Incoming Call Route = 17 514XXX9307 (5 Xlvls<|>
R BOOTP (2) Line Group ID  Incoming Number  Destination Standard  Voice Recording
4 Operator (3)
gg éo"HME'" TimeProfile Destination Fallback Extension
ialin
o TR AR » | Default Value 6935 H323-6935 © v
17 514XXX6939 VoiceMail
17 514XXX6938 FNEOD.
@ 514XXX6936 6936 H323-6936
@7 514XXX6937 6937 6937
1 514XXX6935 6935 H323-6935
)
@(incoming Call Route (8)]
2 WAN Port (0)

Figure 26 — Incoming Call Route for Inbound Toll-Free
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5.10. Save Configuration

Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.
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6. Fibrenoire SIP Trunk Configuration
Fibrenoire is responsible for the configuration of Fibrenoire SIP Trunk Service. The customer must
provide the IP address used to reach the Avaya IP Office LANZ2 port at the enterprise. Fibrenoire will
provide the customer necessary information to configure the SIP connection between Avaya IP
Office and Fibrenoire. The provided information from Fibrenoire includes:

e [P address and port number used for signaling or media servers through any security

e DID numbers

e Fibrenoire SIP Trunk Specification (If applicable).
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7. Verification Steps
The following steps may be used to verify the configuration:

e Use the Avaya IP Office System Status application to verify the state of the SIP connection.
Launch the application from Start - Programs - IP Office - System Status on the PC
where Avaya IP Office Manager was installed. Select the SIP Line of interest from the left
pane. On the Status tab in the right pane, verify that the Current State for each channel
(The below screen shot showed 2 active calls at present time).

. Avaya IP Office System Status - IPOffice_1 (10.10.98.14) - IP500 V2 10.0.0.1.0 build 53 = X

AVAYA IP Office System Status
elp

os
a Status |Utiization Summary  Alarms
SIP Trunk Summary
Lin Line Ser In Service
o f-voip.com
; J : 162.168.104.164
A
o R Line Number: 17
Number of Administered Channels: 50
Number of Channels in Use: 2
L Administered Compression: G711 M
Enable Faststart: off
Sience Su off
Media Stream: RTP
Layer 4Protos uop
SIP Trunk Ch: 128 . -
SIP Trunk Ch: 2
SIP Device Feature:
Codec  Connection Type Caller ID or Other Party on Call Direction of Call Round Trip Delay Receive Jitter  Receive Packet Transmit Jitter  Transmit Packe!
Dialed Digits Loss Fraction Loss
1 1 126 ected 00:01:23 192.168.104.164 | G711Mu | RTPRelay | 161300(5280... FExtn 6935, H323-6935 Incoming ~
2 0 132 || Connect ted | 00:00:09 192.168.104.164 | G711Mu RTP Relay Extn 6937, SIP-6937 Outgoing
3 1de 00:00:19
4 1de 02:54:06
5 Tde 02:54:06
6 1de 02:5406
7 1de 02:54:06
8 1de 02:54:06
9 1de 02:54:06
10 1de 02:5406
11 1de 02:54:06
12 Ide 02:5406
13 Ide 02:5406
4 1de 02:5406
5 1de 02:54:06
16 1de 02:54:06
17 1de 02:54:06
8 Tde 02:5406
B 1de 02:54:06
2 1de 02:54:06
21 1de 02:54:06
2 Tde 02:54:06
3 1de 02:54:06
24 1de 02:54:06
25 1de 02:54:06
% 1de 02:5406
27 1de 02:54:06
23 1de 02:54:06
2 1de 02:54:06
30 1de 02:5406
31 1de 02:54:06
32 1de 02:54:06
3 1de 02:54:06
34 Tde 02:5406
35 1de 02:54:06
36 1de 02:54:06
37 1de 02:54:06
Ed Tde 02:5406 v
Trace Trace Al Pause Ping Call Detals Graceful Shutdown Force Out of Service Print.. Save As...

Figure 27 — SIP Trunk status
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e Use the Avaya IP Office System Status application to verify that no alarms are active on the
SIP line. Launch the application from Start = Programs -> IP Office - System Status on
the PC where Avaya IP Office Manager was installed. Select Alarm - Trunks to verify that
no alarms are active on the SIP line.

+J. Avaya IP Office System Status - IPOffice_1 (10.10.98.14) - IP500 V2 10.0.0.1.0 build 53

AVAYA IP Office System Status

Help Snapshot LogOff Exit About

System
B & Alarms (5) Select a line to display the alarm information

Link (0)
Call Qualitv of Servid

Figure 28 — SIP Trunk alarm

e Verify that a phone connected to the PSTN can successfully place a call to Avaya IP Office
with two-way audio.

e Verify that a phone connected to Avaya IP Office can successfully place a call to the PSTN
with two-way audio.

e Use a network sniffing tool e.g., Wireshark to monitor the SIP signaling between the
enterprise and Fibrenoire. The sniffer traces are captured at the LANZ2 port interface of the
Avaya IP Office.
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8. Conclusion

Fibrenoire passed compliance testing excepting the limitation in Section 2.2. These Application
Notes describe the procedures required to configure the SIP connections between Avaya IP Office
and the Fibrenoire system as shown in Figure 1.

9. Additional References

[1] Administering Avaya IP Office Platform with Manager, Release 10.0, August 2016.
[2] Deploying Avaya IP Office™ Platform Solution, Release 10.0, August 2016.

[3] Using Avaya Communicator for Web, Release 1.0, Issue 1.0.6, May 2016.

[4] Using Avaya Communicator for Windows on IP Office, Release 10.0, August 2016.

Product documentation for Avaya products may be found at: http://support.avaya.com. Additional IP
Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/ipoffice/general/rss2html.php? XMLFILE=manuals.
XmI&TEMPLATE=pdf feed template.html

Product documentation for Fibrenoire SIP Trunk may be found at: https://www.fibrenoire.ca/en/sip-
trunking-provider.
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